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Using the webinar controls & franconnect

Windows/Mac Mobile device

Audio Settings = -
Chat

!l Sprint = 1:01 PM ¥ % 28%m

] off 253-511-159

Raise Hand to get the instructor’s attention

Chat to the instructor to ask a question or make a comment

Q&A is usually used in large meetings, when lots of questions need
to be prioritized
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Recording Provided

* This training will be recorded
* You'll be sent a link to view the recording at any time

REQUEST A DEMO

? fl’anconnect Solutions Platform Overview Resources About Contact Us Q

On Demand Courses

Session One: Get Your Data Straight

01 The five critical pieces of information you
should be keeping

02 How to check the quality of your current
information

G ET Yo U R { D . . 03 Recommendations for updating that
STRAIGH1 ' information

*Recorded 9/17/2021

SESSION ONE DOWNLOAD WORKBOOK
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Springboard to Success-Engage
February 2022

| inherited a messy
hub...where do | start?
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You've inherited a Hub instance, and you d
people are using it. In this session, we'll talk a

't know ho

1. Discovering which documents are used m rec

2. Determining how well your search capabMty%

'

3. Discovering which documents haven't been ug

Springboard Take-Aways:
Analyze your Hub usage logs to see whats working and what could use some heip.
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| MONITORING HUB USAGE

All hd Type and press enter Q 0 E @ FranConnect Administrator ~

YSTEem Users settings - manage users and their login credentials and export usars information.

" P PO T bt e 9. BN s R gt ™ v

BackTaTop

Site Clearance

ﬁ-. Access Control

@ Opener
v InfoMgr Manage logs for actions performad, define users roles and parmissions and modifications made in different entities of the system. You can set filter parameters
= to view log reports corresponding to the desired criteria.
< TheHub * Roles = User Account Summary
Define user roles and associate privileges with View account details of all user categories for
& Support them. a selected duration.
= User Status Logs = Login Logs
B  Training View status logs for system users for a defined View detailed login reports of various system
duration. users for a selected duration.
#  Royalty Mgr » Deleted Logs = Exportlogs
View detailed records of deleted entries fora View records of system exports in a selected
41 Visits defined duration. duration.
= Form Generator Logs = Web Form Generator Logs
@ Zip/Postal Code Locator View logs of activities done through Form view logs of activities done through Web Form
Generator. Generator.
Marketing » Tab Generator Logs * Visit Form Logs
View logs of activities done through Form View logs of changes made in Visit Formin a
§ Manage Address Generator for Tabs. given duration.

* Library Logs = The Hub Searched Logs
i CRM View download details of specific library View records of searches performed by
documents. different system users on The Hub module.

= Print Ads
= Mews Logs

View records of news items downloadad by
& Shop VEIious users.
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‘ What documents are popular?

d press enter Q,

= ?franconnect Al | Type ar

Admin= Access Contral = Library Dosumends Logs

e

All Selectad

LIBRARY LOGCS REPORT e 4 - 20 of 48 | First | Prey [ | 2| 2| Newt | Last

User Hame Document Title Folder Name Ho. of Download Last download Date » IP Address

FranCarmect Administrator Wideo =R 4 L ek L T e T1.163.164.79

FranCanmect Administrator Yideo HR 4 02202022 T1.163.164.7%

FranCanmect Administrator Wideo HR 4 T1.163.164.79

FranCannect Admindstrator Getting Started Guide Branding and Marketing 1 027042022 T1163.164.7%

FranCannect Administrator Ae-Dp=ning Guidance_Mod Recon n T1.163.164.7%

FranCannect Admindstrator Sunrize w Fomt SUNBISE FLYERS 3 162201 37 334

FranCannect Admindstrator Sunsise Drop-0fF SUNRISE FLYERS 1 1220127 154

FranCannect Admindstrator FastFacialForm Bic-Dispes 1 162201 37 334

CO0 Exscutive Qperations Manual Overview Operations 4 10726 2021 2600:1700: 902 1:1 2e0:2635:157 2:0086 14018
FranCarmect Administrator 2015 Product Brochune Brochures = 10,0620 1 W2 TT LT

FranCannect Administrator Buageting Warksneet Operations 15 100.36.35.227

FranCanmect Admindstrator Ssles presentation Smims 13 10/00/3021 2600:1700:9ce1:1 2el:E18:0 T7 8 skn1 00
FranCarmect Administrator Pl Cromraimyy Marieting 2 1070172021 Z2600: 12005180077 30k 1 as
FranCanmect Admindstrator Operations Maruzl Dverview Operstions g 10/00/3021 2H00:1700: 5011 20 0:5080:0 77 3: 9 sk 20
SME Ewecutive Ops Manual - Diperations 1 03/30 Mz 2B8.168.291. 101

SME Exscuttive Operations Manual Creerview Operations 4 023002021 SH.168.251.201

FranCanmect Admindstrator Y& primary bogo - 1 color - ra tagline Humen Resources 1 02282001 223177131114

CEQ Executive Qperations Manual Oeerview Operations T 02232021 2a09:8064: 500 THY:00T 2:1 BB 30 n 255
CEQ Executive SEA Disamster Aopistance Azca E] 0223001 2208206800 THE T sl Eclic e i 25

CEQ Executive Ops Manuail - Word Operations 3 08/23/ 2021 2803:4064:90,: THI: 08T 2:1 GcBic 2ad: 255




DO A LITTLE CLEANUP ON THE EXCEL FILE

« Convert No. of Downloads to a
number by highlighting the
column and clicking the error
icon. Choose “Convert to
Number”.

- Convert dates that look like
text by doing a search and
replace (Ctrl-E-E), and
replacing the / character with
itself.

\> franconnect

1
2
3
4 —
5 |Abigail Duncan NY-07 Tier 4 Tier 4 2 01/11/2022
6 |Abigail Duncan NY-07 Tier 4 - I 01/11/2022
7 |Abigail Duncan NY-07 Tier 4 Mumber Stored as Text I 01/11/2022
& |Abigail Duncan NY-07 Tier 4 e e |ﬁ 01/11/2022
9 |Abigail Duncan 2021 VA-01 Tier 3 : I 01/11/2022
10 | Abigail Duncan 2021 VA-01 Tier 3 Help on this Error 5 01/11/2022
11_ Abigail Duncan 2021 WA-01 Tier 3 Ignore Error 2 01/11/2022
12 | Abigail Duncan VA-01 Tier 3 Separe 7 01/11/2022
13 | Abigail Duncan VA-01 Tier 3 Separe o 7 01/11/2022
14 | Abigail Duncan VA-01 Tier 3 Separe Error Checking Options... |7 01/11/2022
15 | Abigail Duncan 2021 N1-02 Tier 3 Tier 3 7 01/11/2022
AR L ahinail Munean N1 MI-NT Tiar 2 Tiar 2 %’ IR NEE Firlilel]
Find and Replace ? >
Find Replace
Findwhat: |/
Replace with: |;"
| Replace All | | Replace | FindAl | | FindNext | = Close |

73.49.19.16
73.49.19.16
73.49.19.16
73.49.19.16
73.49.19.16
73.49.19.16
73.49.19.16
73.49.19.16
73.49.19.16
73.49.19.16

73.49.19.16
72 40 10 14
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PIVOT!

 Highlight the table from the headers
down, and choose Insert > Pivot Table >
From Table/Range.

» Choose to put your results into a new
worksheet.

\> franconnect

ﬂ AutoSave OTF Hub Usage 12-22-2021.xlsx -

| Insert §Draw  Page Layout  Formulas  Date

o)
i
el Recommended Table Pictures
ivotTables w ﬁ'[j a0 Madels  ~

Hlustrations

- -

- [ Shapes ~ =5
|| apes = 31T
H O shap

t‘,ﬁ lcons él S

EH From Table/Range

From External Data 5 R
b From Sxtermal tata source PivotTable from table or range.

] Create a PivotTable using dataina =
4

table or range.
L |Lauren Trurzun S

Select a table or range

Table/Range: | ‘Library Docs Downloaded 15454 5F541577 +
Choose where you want the PivotTable to be placed

(® New Worksheet

Laocation: +

Choose whether you want to analyze multiple tables

|:| Add this data to the Data Model
11
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‘ FINDING THE MOST DOWNLOADED DOCUMENTS

Drop Report Filter Fields Here

Sort (Document Title)

|Ducument Title
$100 10 Pack Employee Discount

Sart options

() Ascending (4 to Z) by:
Document Title
(® Descending (Z to &) by:

Document Title

O Manual (you can drag items to rearrange themj

Document Title

Sum of No. of download
5o Count of User Name

e e e e R e L T I e R B R I =5 ]

Document Title

o 00 =] o0 M &= W R =

- Sum of No. of download Count of User Name

2021 Hell Week EOS Quantities

Facilities Guide - for 8-point SMS

3 Class Session Bundle - Client Intake and Waiver (All States)
Tier 1-4 Membership Freeze Form

I A
3R R R R PRI RI RIR

PivotTable Fields EAE
Choose fields to add to report: @}‘ -
Search /O

User Name
Document Title
] Folder Name

No. of download
[] Last download Date
] 1P Address

[] Quarters

[ Years

More Tables...

Drag fields between areas below:

T Filters Il Columns
¥ Values -
= Rows = Values
Document Title & Sum of Mo. of download ~
Count of User Name e

Defer Layout Update



When were files last downloaded?

* If a file hasn't been downloaded in a while, it might be
out of date. Let's add Download Date to our Pivot table.

* |t comes in as “count of date”, which we don't want. Left-

click on the field and choose “Value Field Settings”.
Choose “Max" as the summary option. Click OK.

\> franconnect

Value Field Settings ?

Source Mame: Last download Date

Custom Mame: |Max of Last download Date

Summarize Values By  Show Values As

Summarize value field by

Choose the type of calculation that you want to use to summarize

data from the selected field

Sum Y
Count

Min
Product b

MNumber Format Cancel

A'l.reraie

Choose fields to add to report: ﬁ’} -

Search }3

User Name
Document Title
[] Felder Mame
No. of download

Last download Date

|| IF Address
ED Quarters
'-_|:| Years

‘t-ﬂDrETables...

’0
Drag fields betwedmagreas '
g q"'-----.M.':L‘-‘EQP

T Filters

*
*
Move to BEgin'nng
*

*
*
T Moveto Report Filter %,
*
Il Moveto Row Labels

.

.

= Moveto Column Labels o
.

= Rows

: 7% Remove Field
Document Title

llllllllllllllllllllllllllllll i '|'||l'a||-IE FlEld SEttiﬂS...

Count of Last downloa... ™

Mefer | mwvmnt | ladate

v
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» The date shows up as a number, so let's correct that display. Highlight the column
containing the date and change its display to Short Date.

Data
= = ¥~ W~ 25 Wrap Text ﬂ > E < Sum of Mo. of download Count of User Mame |Max of Last download Date
N T T i o o
Mo specific format 1840 260 1212212021
Alignment E Number 1650 429 12/20/2021
12 1614 774 1212112021
1621 216 127192021
c O E - Currency 1516 844 12/21/2021
@ 1491 495 1272172021
1316 760 121072021
=]  Accounting 1312 820 10/29/2021
of User Name |Max of Last download Date S| 1218 255 12/20/2021
1840 445928 o 1215 300 11/30/2021
144 44552 — Short Date 1156 752 10/29/2021
260 44552 1128 652 1272172021
Aan Adcen 1080 405 1272202021
1014 192 12/14,/2021
1004 676 1272172021
on amA AT TN
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CONFUSED BY PIVOT TABLES?

We have templates for the File and Search logs

Pull your log

Paste it into the tab that says “paste here”
Clean up the numbers and dates

Go to the Pivot Tables tab and press Alt-F5

W=
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What are your users searching for, and do they find it?

All b Type and press enter Q, g ﬁ @ FranCannect Administratos
Admin = Access Control > Searched Logs

Searched Text Searched Date

Search The Hub Logs All w

SEARCH ED LOGS s - 18 af 15

Searched Text Searched Date - Searched By Searched Results Item

VY WS S S eRee S ey S N T PURR e Y SV R

new gverdew . Aye0l9 0318 Pl FranConnect A. ..anistrator . Al Th H
sales presentation 091302019 03:28 PM FranConnect Administrator 1 All The Hub Items
salis manual 09/30/2019 03:28 PM FranConnect Administrator 1 All Th Hub Items
FIM_CAMPAIGN_DOCS 0572972019 0&:25 PM FranConnect Administrator 1 All The Hub Items
Georgia 01172009 06:14 AM Mick Mecozzi 1 All Intranes Rems

Export As Exced § “ri

& 20042022, FranConnect LLC Al nghts reserved Pewered By q franconnect
LE

I ——_n
\> franconnect 16



- Enter the time period for searches,
one year is a good representation

« Choose search
« Export the result to an Excel file

\> franconnect

? franconnect

Admin = Access Control = Searched Logs
Searched Text Searched Date
Search Thw Last 12 Months ~

SEARCHED LOGS

Sea ed Text

Covl

Export As Excel | Print

All

W

Type and press enter

Searched Date

02/16/2022 05:36 AM
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DO A LITTLE CLEANUP ON THE EXCEL FILE

« Convert No. of Downloads to a
number by highlighting the
column and clicking the error
icon. Choose “Convert to
Number”.

- Convert dates that look like
text by doing a search and
replace (Ctrl-E-E), and
replacing the / character with
itself.

\> franconnect

1
2
3
4 —
5 |Abigail Duncan NY-07 Tier 4 Tier 4 2 01/11/2022
6 |Abigail Duncan NY-07 Tier 4 - I 01/11/2022
7 |Abigail Duncan NY-07 Tier 4 Mumber Stored as Text I 01/11/2022
& |Abigail Duncan NY-07 Tier 4 e e |ﬁ 01/11/2022
9 |Abigail Duncan 2021 VA-01 Tier 3 : I 01/11/2022
10 | Abigail Duncan 2021 VA-01 Tier 3 Help on this Error 5 01/11/2022
11_ Abigail Duncan 2021 WA-01 Tier 3 Ignore Error 2 01/11/2022
12 | Abigail Duncan VA-01 Tier 3 Separe 7 01/11/2022
13 | Abigail Duncan VA-01 Tier 3 Separe o 7 01/11/2022
14 | Abigail Duncan VA-01 Tier 3 Separe Error Checking Options... |7 01/11/2022
15 | Abigail Duncan 2021 N1-02 Tier 3 Tier 3 7 01/11/2022
AR L ahinail Munean N1 MI-NT Tiar 2 Tiar 2 %’ IR NEE Firlilel]
Find and Replace ? >
Find Replace
Findwhat: |/
Replace with: |;"
| Replace All | | Replace | FindAl | | FindNext | = Close |

73.49.19.16
73.49.19.16
73.49.19.16
73.49.19.16
73.49.19.16
73.49.19.16
73.49.19.16
73.49.19.16
73.49.19.16
73.49.19.16

73.49.19.16
72 40 10 14
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VIEW YOUR RESULTS

A B C
What are people searching for?

Press Alt- F& to refresh Sort A-Z to find similar terms near each other

* View your results, and consider
adding these terms to document

Data
descriptions Searched Text «T|Max of Searched Date Count of Searched Results

COVID 2M16/2022
finance 1072272021
kitchen 4/1/2021
no color 92472021
no tagline 9/24/2021
opeerations 32412021
Operations 8/18/2021
Operations Manual Overview 10/27/2021
(blank)

Grand Total 2/16/2022

5 M =k =k =k =k =k | =h| =k =k =k =k
Il C DO~ REQMNMao PO e WD 2

\> franconnect
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‘ How current, and how searchable are YOUR documents?

= ? franconnect

The Hub = Library

FOLDER

Home

Index

.SUNRISE FLYERS

Area Developer Toolkit
Branding and Marketing
HR

Human Resources
Marketing

Opening Documents
Operations

Recovery

Sales

Vendor Information

&P Quick LinkleNotifications

\> franconnect

All

v

Type and press enter Q

INDEX

Document Type Document Subtype SortBy

All All v Select ~

<

Search Save View

Document Title liSummary |
G D A e how to get started with FC

uide
Here's how you can include fillable flyers without the Ads
Sunrise w Font iy
Sunrise Drop- BE) e PDF to store
Off
FastFacialForm [JlFill this out for FastFacial Training

VA primary logo

-2 color - no

Use this version of the logo for two color printing

Last Update

H =E =

o a @ FranConnect Administrator ~

Search All The Hub Items Search Exact Phrase (]

Recommended Documents

Delete Set as Default View

Uploaded By

Branding and FranConnect
o
SUNRISE FLYERS [l /2 Connect [@v]
. Administrator
SUNRISE FLYERS [l r2nconnect [%v]
i Administrator
= FranConnect
FranConnect
@

FranConnect

Human Resources

-

20



Copy from your page (Ctrl-C), and paste SPECIAL so you don't get any control features from
the page...(Alt-E,S,T)

Choose to sort by the headers (highlight header row - Data > Filter > Sort

File Home Insert Draw  Page Layout  Formulas eview View Help Acrobat  ASAP Utilities
Queries & Connection NS = v
R E R Eo - =l - R=
L |:| =
Frarn  From  From Table/ Recent g Refresh Stock G P z ort I Textto  Flash  Remove Data Consalidate
Data Text/CSV  Web Range  Sources Cglliecti All~ ["1 o Fography | A Ehdvanced Columns  Fill  Duplicates Validation ~
Get & Transform Data Queries & Connections Data Types Br Data Tools

3 Sunrlswont Here showyu can include fillable flyers without the Ac 12/8/2021 3 SNRIS L‘fE - FrnConnectAdministrtor
4 | Sunrise Drop—Of'f Flllable PDF to store 12/7/2021 1 .SUMRISE FLYERS FranConnect Administrator
Check your keywords Check your Update Better yet, sort by
against the ones dates. Sometimes old uploader and
searched for stuff is still valid, but... distribute the work!

\> franconnect
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Who's reading the news?

 You can do the same research about how popular your Hub news stories are. Run the
News Logs for the desired period and export the results to analyze.

« This is a great place to find power users to be your advocates!

“Fram Date *To Date

01/15/2022 @ 02/15/2022 i |

NEWS LOGS REPORT

User Name Document Title Folder Name

Items 1 -20 of 29 | First | Prev |1 | 2| Next | Last
No. of Download Last download Date v

4 02/15/2022
2 02/14/2022

4 02/14/2022

\> franconnect
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NEXT STEPS o5

Now that you know what's what:

1. Remove or update outdated documents. Don
all your old URLSs to it will point to the new @

2. Update document descriptions to aid searchr '
searches in the Title and the Description. “

3. Review your folder structure - is it how you WOU n '
navigate to documents?

ur

Springboard Take-Aways:
Analyze your Hub usage logs to see what’s working and what could use some he/p Then update it!

é franconnect



vhat's on your mina?

o




If you think of a question after this session...

Email us and we'll find the answer!

training@franconnnect.com




